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Understanding Queries
in BSD CostLink/CM ®

Effectively Preparing
and Using Outline

Specs
Query (kwîàç) noun [from Latin
quaerere, to ask] 1.a. A request for
information: QUESTION. b. An inquiry.

Unless you have done a little relational
database work, the word query may not
be one that rolls off your tongue.  But
BSD CostLink/CM provides a special
query capability to greatly expand your
ability to find and view specific items in
your project.  For example, you might
design a query to show only those
tasks that have a cost to the prime
contractor of $100,000 or more.  After
the query is run, the sheet panel
displays only those tasks that match
the query criteria, and you can review
those costs easily.

When you opened the View pulldown,
you may have noticed one or more
primary views indicated by a question
mark.  These views are the results of
queries.  The Zero Cost Items query
comes with the software and is a useful
tool for finding cost items where you

may have forgotten to enter a quantity.
Other query examples can be found at
the end of this article.

To build your own query, go to the Tools
menu and select Create Query.  (Figure
1, Page 2)  You can construct queries
based on any of the fields stored for
tasks in the database and you can use
both defined values for the fields and
wildcards.  Using the pulldowns, select
a field name and an operator, and then
enter a value.  For example: Cost to
Prime is greater than 5000 ($).  You
can build a query using multiple sets of
criteria by selecting And or Or.  For
example: Cost to Prime is greater than
5000 ($) or task Duration is greater

than 100 (Hrs).

Queries may be run one
time only, or saved within
the database.  Each
query that you define and
then save becomes a
new view of the database,
and can thereafter be
accessed at any time
from the View pulldown.
To save the query, click
the Create button in the
query box and select a

name.  When you rerun a saved query,
it will reflect a new subset of the current
data (including any changes).  If you
want to run it one time only, simply
click on the Do Query button.  If you
find a query that you use often, you can

Outline specs are popular
because they are brief, easy to
read and understand, contain

only the essentials, and are not
encumbered with legalese and jargon.
On the other hand, they are usually too
imprecise to be used as the basis for
competitive bids. The primary function
of an outline spec is to communicate
decisions about materials and equip-
ment before the drawings are complete
enough to do so. Secondarily, the
process of writing an outline spec often
facilitates the making of those deci-
sions, because decisions must be
made before they can be written down.
In addition, using an outline spec at an
early stage helps avoid putting too
much detail on the drawings too soon.
And, lastly, in some cases�mostly on
small, low-risk projects�outline specs
can be used for contract documents.

A NEWSLETTER FOR BSD SOFTLINK® CUSTOMERS AND FRIENDS
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Q&A
BSD SpecLink

I am trying to copy a custom
spec section that I wrote in Word

into SpecLink, but it came in as one
huge paragraph.  What did I do wrong?

Rather than Copy, you want to
use Import from Clipboard.  Copy

the text as you would in Word, but
when you switch back to SpecLink,
position the cursor on the paragraph
above where you wish to paste the
imported text.  Then select Import from
Clipboard from the Tools menu.  The
indents or tabs in your Word file will
determine the levels of the imported
text.  If you want to change the text
levels, use Promote or Demote Para-
graph from the toolbar or the Paragraph
menu.  Contact technical support for a
couple of macros that can be used to
clean up a Word document before it is
imported into SpecLink.

We archive our old projects to
CD.  When I copied one of these

archived files back to my hard drive, I
could not open it.

Files copied from a CD-ROM
have their attributes set to read-

only.  You can change the files at-
tributes by right clicking on the file in
Windows Explorer and selecting
Properties.  Go to the attributes at the
bottom of the screen and uncheck the
Read-Only box.  You now will be able
to open the file.

I accidentally added a word to
my SpecLink dictionary that was

misspelled.  How do I remove it?

Words commonly used by you
that are not found in the standard

SpecLink dictionary (which contains
over 50,000 words commonly used in
architecture and construction) can be
added to the custom dictionary.  This is
a simple text file named CUSTOM.DCT
and it is found in the SpecLink folder of

create it in your template so that it is
there when you start a new project.

By default, only the sheet panel is
shown when you view query results.  To
see the resultant tasks with their parent
folders shown in the tree panel, go to
the View menu and turn off the All
Tasks in Sheet option.  You can build a

new query based on a previous query
by clicking in the box at the top of the
query form.

When viewing query results, keep in
mind that assemblies are tasks, and
may therefore be included in any query
results.  To dismiss the query results,
select a different view in the View
Pulldown.  You can delete previously
saved queries by selecting Delete
Query from the Tools Menu.
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Query Examples
This table shows the queries you would enter to achieve the desired results.

Queries
continued from page 1

Figure 1:
Create Query box and the resulting task list in the sheet panel.
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your installation.  This file can be edited
using a text editor such as WordPad
and you can add and delete words to or
from it directly.

I inserted the project name into
the footer, but it is too long and

wraps funny.

In this project, rather than use
the keyword for the project name,

type the name into the footer field
directly, and then use the Enter key to
insert the line break where you want it.

I wanted to create a new section
that I could specialize for a

project, so I copied an existing section
to get started.  I�ve noticed that the
initials next to the numbers have
changed from BSD to USER.  What are
the implications of this?

The new section you created is a
User section.  The main thing to

remember about a User section is that
it does not get updated with the master
each quarter.  So while User sections
are necessary when you have a unique
product or method, it is important to
remember that they must be updated
by their author, you!

How do I get my user-added
spec sections to show up in the

Table of Contents?

People often confuse the Table of
Contents report with the section

00010BSD Table of Contents.  User
added and selected sections will show
up automatically on the Table of
Contents report, which can be printed
from the Print menu, Report Option of
Table of Contents.  If you want to use
the 00010BSD section, you would have
to manually add paragraphs to reflect
user-added sections, just like when you
edit any other section.

I would like to copy a bunch of
sections to create a new master.

Will my links copy as well as the text?

When you copy a section, the
link targets between paragraphs

copy as well, but the larger issue is
that of creating a new �master�.  BSD
SpecLink is shipped with a master

database that is updated and shipped
to our customers quarterly.  By restrict-
ing user access to this master we can
ship updates that do not affect your
user choices and additions.  To create
an �office master� you simply start a
new project and make the changes
desired for your master database.
Then, each time you want to start a
new project, you start from your office
master project.

So how can I make sure that my
�office master� is used each time

I start a new project?

First, make sure that all your
existing projects are closed.  Go

to the File menu and choose Select
Project Setup.  In this window enter the
name of your �office master� project.
Any existing project can be selected.

Did you know?  The listing of all
specifications sections and the

catalogs they are part of is available
electronically on the CD as well as on
the hard copy that we send with your
quarterly update.  Use Explorer to open
the CD and look in the
Pricing\SpecLink folder.  The
document�s name is the same as that
of the CD (example: Fall2000.doc).

CostLink/CM (M32)

I have added vendors to one of
my templates, and now I would

like to copy them to a new template for
a different project type.

Simply open the two templates
side by side (you can use Tile

Vertically from the Toolbar or the
Windows menu).  Next, use the View
Selector pulldown to change to the
Vendor Resource view for each tem-
plate.  Now simply highlight and drag
the vendors and/or folders you want into
the new template.

I appreciate being able to add a
hierarchy to my estimate from

the hierarchy library rather than having
to build it from scratch.  This is espe-
cially helpful when I want a different
WBS for my project buildings and

another for the site.  The only problem
is that my estimates end up with lots of
empty folders that don�t have cost
items in them.

When you have finished adding
cost items to your estimate,

select the primary view with the empty
folders.  Go to the Tools menu and
select the Delete Empty Folders
option.  This will remove any folders
that do not have tasks.

I finished my estimate and then
switched to the CSI View and

Assigned Tasks to Hierarchy to get a
CSI summary.  I then had to add some
additional cost items and they ended
up in the Unassigned folder.  How
come?

Whenever you add costs to your
estimate, they are placed in the

Unassigned folders in all of the other
alternate hierarchies until you assign
them.  You can assign them three
ways: by opening the Item Form and
selecting the folder on the Accounts
tab, by dragging the cost items from
the Unassigned folder into the desired
folder, or, in the case of CSI View,
running Assign Tasks to Hierarchy
again to reassign the cost items you
added.
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Q & A
cont. from page 3

I have been a CostLink user for a
while now, and I just upgraded to

CostLink/CM.  Why are the Labor,
Equipment, Crews, and Unit Price
databases all in one big database now?

One of the major changes in
BSD CostLink/CM is the way

that it handles project resources: labor,
equipment, crews, and materials.  The
new CostBook database stores CSI
tasks as well as materials, crews,
labor, equipment, modifiers, and
vendors.  When you copy a cost item
from the CostBook to your estimate,
the resources are copied also.  This
allows you to review and manipulate
project resources directly without
changing the CostBook.  Alternatively,
you can also choose to work in data-
base �reference� mode, which main-
tains the resources in the CostBook,
similar to the way CostLink handled
data.

I have finished adding a work
breakdown structure (WBS) and

costs to my estimate, and now I would
like to rearrange some of the items.  Is
there an easy way to do this?

While it is easy to drag and drop
estimate items using your left

mouse button, you will find that there
are a number of helpful options on your
right mouse button.  If you drag using
the right mouse button, you will see the
pop-up menu shown below .  Select the
option you wish and the estimate items
will follow.

I have a very large estimate and
when I print reports, I get an �out

of memory� error.

In a very large estimate, you
might encounter this problem,

typically when you select to include the

Table of Contents.  Crystal Reports
stores your page numbers in memory
as your detail and summary reports
print.  When you have an estimate with
a large number of folders, and you
select the Table of Contents, especially
to level 3, 4, 5, or 6, Crystal Reports
may run out of memory.  Overall
performance depends on your
machine�s memory and your actual
estimate.

The Cost Override feature that
was available in BSD CostLink

does not appear to be there in
CostLink/CM.  What should I do?

Many people used the Override
function in CostLink to enter

subcontractor quotes.  You can do the
same thing in CostLink/CM by using
the Omit function available on the Item
Form.  If you want to estimate a portion
of a project that you intend to get a
quote on, structure your estimate so
that those line items are under a single
folder (this can be done in any view).
When you get a sub quote you want to
use, go to the folder where you esti-
mated the cost, open the Item Form,
and click on the Omit box.  The omitted
folders and tasks now appear with a red
X next to them so that you can see
they are omitted.  Close the folder,
choose Insert Task, and enter the
subcontractor quote.

Omitted items are not deleted from
your estimate but they are not included
in your estimate total.  (If you are
showing totals in the Tree you will see
a zero cost.)  If you want to revert back
to your original estimation simply
uncheck omit on your folder, and Omit
the subcontractor quote task.

CostLink (MFW)

I have been printing my estimate
reports, including the labor,

equipment, and crews backup reports,
but now suddenly the backup reports
are not available.

Look and see that the estimate
type has been changed from A �

Auto Recalc with Crews to U � Unit
Cost.  The estimate type must be

changed back to A � Auto Recalc with
Crews for the backup reports to be
available for selection.  The U � Unit
Cost estimate type does not use crew
data to calculate the unit labor and unit
equipment costs.

I have added a cost item to my
estimate, but when I recalculate,

the cost item does not appear to be
added to the total.

Check the title above the cost
item you added and see if there

is a cost override.  This override
supercedes the sum total of the line
items below it.  You can see which
titles have cost overrides by looking in
the Override column of the outline panel
(for information on how to do a cost
override in CM, see the appropriate
question above.)

The 32-bit version of SpecLink is
almost�but not quite�ready for
distribution. We still lack the require-
ments reports used by many of our
subscribers for construction administra-
tion. We also are continuing to work on
optimizing the speed of the software.
Current plans call for releasing Version
1.0 on the Winter 2000 update.

We have added the ability for users to
insert pop-up choices in paragraphs
they have added to a master project. All
the choice types are available�
exclusive and inclusive multiple choice,
optional choice, global variables, units
of measure, etc. We have also com-
pleted the user linking feature. Now you
can add links to and from choices, as
well as links between paragraphs. Both
these features should be especially
useful for office master projects that are
used by many different people.

There is also one more new feature that
is especially exciting. We have
changed the Notes window to permit
insertion of hyperlinks as well as
graphic files. Now users will be able to
add their own internet addresses and
project photos and drawings to the
project note for any paragraph.

BSD SpecLink®/+ Update
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About Your SpecLink Update

For information about �ASTMs in Building Codes�, published in late
June, call (610) 832-9585 or see www.astm.org.  The cost is $795,
which is an outstanding value over other purchasing methods.

Notable Changes to Referenced ASTM Standards:
� ASTM C 129, on non-loadbearing cmu, now allows chips up

to 1 inch in dimension for up to 5% of a shipment.
� ASTM C 645, on metal drywall framing, includes some

changes to material dimensions that are potentially significant.
� ASTM C 754, on installation of drywall framing, includes new

mandatory stud height limit tables.
� ASTM C 1063, on the installation and support of portland

cement plaster, contains a completely different set of criteria
for hanger and support spacing; this is a standard referenced
for the contractor�s use in designing supports.

� ASTM D 25, on wood piles, now includes the size tables as a
non-mandatory appendix rather than mandatory criteria.

� ASTM D 225, on asphalt shingles, now requires Class C fire
resistance and ASTM D 3161 wind resistance.

� ASTM F 1066, on vinyl composition tile, ASTM F 1303, on
sheet vinyl floor covering, and ASTM F 1700, on solid vinyl tile,
all include new material properties not specified before.

BSD SpecLink Statistics:
� 725 sections total, 377 updated (50 %)

� 429 non-proprietary sections, 204 updated (45 %)

� 296 proprietary sections, 173 updated (58 %)

� 38 new sections

� 128,153 links

� 133,388 paragraphs

� 1,915 external documents referenced

� 167 standards organizations

� 898 ASTM standards verified and evaluated

� 253 new or updated ASTM standards

� 9 ASTM standards withdrawn

� 324 sections affected by ASTM changes

ASTM Standards:   Standards published by American Society for
Testing and Materials (ASTM) make up 45% of the 1915 docu-
ments referenced in SpecLink -- the largest number published by a
single organization.  All of the ASTMs referenced in SpecLink were
verified in the last quarter.  Revised standards were compared to
previous editions and evaluated for their potential effect on the
specifications, before updating the sections to the new edition
dates.

Monitoring the continual and irregular changes to ASTMs might be
an almost impossible project, except that ASTM publishes an
annual compendium of the standards referenced in the model
building codes, SpecLink, and other guide specifications. Only 11
of the ASTMs currently referenced in SpecLink�s non-proprietary
sections are not included; those will be included in the next edition.

The use of this compendium, �ASTMs in Building Codes� as the
definitive edition is good for SpecLink subscribers in several ways:
1) SpecLink sections can be kept up-to-date relatively economi-
cally, 2) subscribers can obtain copies of most of the relevant
ASTMs at a highly discounted price, and 3) contractors no longer
have any real excuse for not having the relevant edition on hand if it
is needed.
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Obsolete ASTM Standards:
� ASTM A 616 and A 617, for steel reinforcing bars, have been

replaced with a new standard covering both types:
� ASTM A 996/A 996M.
� ASTM C 1050, for polystyrene/cellulose board composite

insulation, has been discontinued without replacement.  It is
uncertain whether this product is still manufactured.

� ASTM C 1388, for masonry compressive strength testing, has
been discontinued, SpecLink now references C 1314.

� ASTM D 290, on bituminous mixing plant inspection.
� ASTM D 4099, on vinyl windows and sliding glass doors, last

revised in 1995, has been discontinued without replacement.
Refer to AAMA/NWWDA 101/I.S.2 for essentially the same
criteria.

Other Referenced Standards:  The vast majority of the over-200
standards developing organizations (SDO�s) whose documents are
relevant to construction specifications have review and updating cycles
that are irregular and unpredictable.  That means that it would be very

02822  Polyvinyl Chloride Fences (UltraGuard; prefabricated
fences)

02834  Modular Concrete Retaining Walls (Rockwood; interlocking
units, with/without geotextile reinforcement)

03933  Concrete Patching (Sonneborn/ChemRex, vertical,
overhead, and horizontal patching)

04085  Masonry Anchors and Accessories (Heckmann Building
Products; anchors, ties, plates, weeps, vents, flashing)

04095  Masonry Weeps and Moisture Control (Masonry Technol-
ogy Inc.; corrugated polystyrene weeps, slip sheets,
accessories)

04220  Concrete Masonry Units (Smithtown Concrete Products;
architectural units)

04730  Simulated Stone (Cultured Stone Corp.; interior/exterior
nonstructural lightweight veneer facing)

05520  Handrails and Railings (UltraGuard; Star System, snap
tight pre-engineered aluminum railings)

06251  Slotted Display Paneling (Marlite; decorative interior wall
panels for merchanidising display)

06605  Fiberglass Reinforced Plastic Panels (Marlite; decorative
polyester sanitary wall surfacing)

07190  Water Repellents (PROSOCO; for above-grade masonry,
concrete, tile, and natural stone)

07311  Asphalt Shingles (GAF; steep slope granular surfaced
reinforced fiberglass shingles)

07410  Metal Roof and Wall Panels (Aluma Shield; urethane
insulated steel panels for commercial, industrial, and cold
storage)

07463  Aluminum Siding (Alcoa; residential and commercial;
including soffits; same products as formerly in Section
07469)

07464  Vinyl Siding (NAPCO; residential vinyl siding and soffits)
07464  Vinyl Siding (Variform; residential vinyl siding and soffits)
07525  Remedial Roof Coatings (Gardner Asphalt; APOC brand,

bright white and aluminum coatings for existing roofing)
07650  Flexible Flashing (Advanced Building Products; copper,

laminated, flexible flashings; masonry accessories)
07650  Flexible Flashing (York; copper, laminated, and flexible

flashings)
08110  Steel Doors and Frames (Republic Builders Products;

standard steel doors, frames, and stick assemblies)
08115  Steel Door Frames (Marlite; adjustable throat design)
08125  Aluminum Door Frames (Marlite; adjustable throat design)
08213  Plastic Laminate Faced Doors (Marlite; high pressure

laminate faced flush wood doors)
08330  Coiling Doors and Grilles (Wayne-Dalton; upward coiling,

service, insulated, ventilated, fire rated doors; coiling
grilles)

08360  Overhead Doors (Wayne-Dalton; non-residential, insulated
and uninsulated steel, aluminum, wood)

09605  Concrete Floor Sealer (DuPont Flooring Systems;
VaprStop(tm) floor sealers)

09640  Wood Flooring (Buell; solid wood and engineered wood
plank flooring)

09655  Interlocking Resilient Tiles (DuPont Flooring Systems;
RepTile(tm) and CrocoTile (tm), adhesive-free; made from
recycled carpet tile and vinyl)

09771  Prefinished Panels (Marlite; �Surface Systems,� �Modules,�
& �Plank� brands; decorative interior wall panels, grid, and
trim)

10165  Plastic Laminate Toilet Compartments (Marlite; melamine,
high pressure laminate, and phenolic; overhead braced)

10670  Storage Shelving (LeeRowan; ventilated wire shelving, for
residential and commercial uses)

10706  Rolling Shutters (Rollac Shutter; rolling shutters of
aluminum and PVC)

11611  Laboratory Fume Hoods (Labconco Corp.; bypass fume
hoods in casework-compatible dimensions)

14422  Inclined Wheelchair Lifts (Garaventa XPRESS; inclined lift
for one flight of stairs)

14425  Vertical Wheelchair Lifts (Garaventa Genesis; indoor/
outdoor platform lift with tower and enclosure)

Section Number Changes:
07311  ELK  Asphalt Shingles (formerly 07310)
09305  SGM  Tile Setting Mat�ls and Methods (formerly 09300-Tile)
11625  LAB2  Biological Safety Cabinets (replaces 11625LAB)

expensive, both money- and time-wise, for an individual specifier  to
monitor these changes - and without a continuous monitoring pro-
gram important updates may not be addressed in a timely manner.

Referencing out-of-date documents will not necessarily cause seri-
ous problems; the consequences are highly dependent on the na-
ture of the document.  For instance, standards that specify minimum
requirements for materials reflect either the prevailing manufacturing
practices or are voluntary standards promulgated by industry groups
- it would be foolhardy to specify a standard for quality that was not in
current manufacture (see ASTM C 1050, under Obsolete ASTM Stan-
dards).  Rather than trying to concentrate only on the important up-
dates, we continuously monitor all standards and make whatever
changes are appropriate.  Some changes are negligible, but it is
impossible to tell how significant a revision will be without a complete
review.  So we kill two birds with one stone: we keep all the refer-
enced standards in the database at approximately the same level of
up-to-dateness, and we find the important updates in a timely man-
ner.

NEW SECTIONS



7

Are Outline Specs Right For You?
The decision whether to use an
outline spec or a conventional

full-length spec is critical. The use of
an outline spec in the wrong situation
may be more dangerous than preparing
a poor full-length spec. Don�t let the
pressure of time convince you that
outline specs are appropriate when
they are not.

The technique for producing an outline
spec with SpecLink is outlined below:

1. Select the sections to be included.
2. Within each section:

� Make product decisions
(PART 2) but don�t select any
execution or administrative require-
ments (PARTs 1 and 3).  Limit the
text included to those items that
convey the important characteris-
tics of the products.
� Preview the section to be sure
it includes the text you need.
� If you wish to eliminate the
incongruous PART 2 PRODUCTS
heading, �hide� it by deleting the
text from the paragraph.  A light
blue icon will appear next to the
paragraph, indicating that the
paragraph has been edited and the
original text is still available.

3. At this point, the sections can be
printed.  Each will start a new
page.

Outline Specs
continued from page 1

Eliminating Page Breaks:  If you
don�t want a lot of short sections on
individual pages, you can export to RTF
and make a few simple changes to
shorten the number of pages:

1. Set the format as desired.  A
variation on CSI format is useful;
just change Level 0 to show the
Section Number and Title on the
same line.

2. Export the sections to RTF.  Each
section will be put into a separate
file, named the same as the
section number/acronym.  The
fastest way to export is to do
Export to RTF once for each
Division.  Specify the same path
(directory) where the files are to be
saved each time.

3. Start Word or WordPerfect for
Windows and start a new docu-
ment.  What you want to do is
make a single file for each Division.
You can do that in 2 ways: 1) just
copy each individual RTF file
consecutively into the Division file,
or 2) create a �master document�
and insert each section file into it in
consecutive order.  If you aren�t
familiar with master documents,
read the on-line Help in Word/
WordPerfect about them � look up
�master documents� and
�subdocuments.�  Master docu-
ments have 3 advantages over
single documents:
� you can work with a lot of
sections at once by opening only
one file.
� undesirable page breaks can
be eliminated.
� the subdocuments can be
replaced without having to redo the
master document.

4.  For ease of editing, we recommend
that you insert a �section separa-
tor� after each subdocument.  This
can be a row of asterisks or
underscores or other symbols.  The
objective is to separate the sec-
tions visually, while making them
run continuously without page
breaks.

5.  If you are using a �master docu-
ment,� once all section files have
been inserted, expand the master
document.  All the text will appear
and can be edited just as if it were

the original file.  You can choose to
leave the subdocuments as
separate files or incorporate them
into the master document (again,
read Help).

6.  There may be some editing needed.
� Word:  To eliminate page
breaks, delete the Section Breaks
that Word inserted. (Suggestion:
Find a Section Break and replace
with a Paragraph Mark.)
� WordPerfect:  If the overall
format needs to be changed,
remove the extra format codes that
were in the RTF files.  Reveal
Codes will show them � Find and
Replace with nothing.  (Note: If you
are going to be doing a lot of this,
making a macro to remove the
extra codes would probably be
worthwhile.)
� There will be a double blank
line just after the title of the section
(where PART 2 is �hidden�).  This
can be removed if objectionable.
(Replace 3 Paragraph Marks with
2.)

7.  When done formatting, each
Division file can be printed.

8.  Save the SpecLink project file for
later in the project.

Changing an Outline Spec to a Full
Spec:  At a later stage in the project,
you can change the SpecLink outline
spec to a full spec without starting over:

1.  Open the original SpecLink project.
2.  Open each section used in the

outline spec; open to show Level 1
only.
� There will be a blank para-
graph between PART 1 GENERAL
and PART 3 EXECUTION.  Click on
that paragraph and then press the
Delete button (or pull down the
Paragraph menu and select
Delete).  This will restore the
original PART 2 PRODUCTS text.
� Expand the text to show all
levels, review the original selec-
tions and edits and make any
changes needed.
� Complete the specification as
required for the stage of the
project.  Usually you will want to
include PART 1 and PART 3.

3.  Print as usual.

REMINDER

Notice of Subscription Price
Change: Effective May 1, 2000,
all multi-user subscription
renewals will be invoiced on the
basis of the actual number of
concurrent users installed,
instead of a fixed price.  To
receive a quotation or to adjust
your firm�s number of concurrent
users, please contact your sales
representative at 1-800-BSD-
SOFT.

continued next page
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BSD SpecLink
1-1/2 day  $395

June 19 - 20
July 17 - 18

August 28 - 29
September 18 - 19

October 23 - 24
November 13 - 14
December 11 - 12

�  Class attendees earn 12 AIA
Learning Unit Hours, all of which

qualify for HSW hours.

Training Schedule

You can now look for BSD class
schedules on our internet site.
Just go to www.bsdsoftlink.com
and go to the training page.  You
will find schedules, maps, hotel
information, and information

about
Atlanta.

BSD CostLink/CM (M32)
3-1/2 days  $1095

June 13 - 16
July 11 - 14

August 22 - 25
September 12 - 15

October 17 - 20
November 7 - 10
December 5 - 8

�  Government Contractors earn
Mcaces Certification.

�  May qualify for Continuing
Professional Competency credits.

Changing a Full Spec to an Outline
Spec:  In some cases, particularly
when you already have an office master
project fully edited, you need to �back
off� from the full spec to an outline
spec.  That�s even easier than building
an outline spec in the first place.

1.  Open the original SpecLink project.
2.  Open each section used in the

outline spec; open to show Level 1
only.
� Exclude PARTs 1 and 3, by
double-clicking in the status box
until it shows as half blacked out.

� Expand the text to show Level
2 and exclude Articles that are
unimportant at this stage.  Ex-
amples would be �Accessories�
and �Fabrication.�
� Go to the remaining articles
and exclude paragraphs and sub-
paragraphs that are not needed.

3.  Print as usual.
4.  When you want to change the spec

back to a full spec it will be easy to
identify paragraphs that need to be
re-selected � they are clearly
marked by virtue of the fact that

you excluded them rather than
simply de-selecting them.  Note
that any manual selection in a
branch that is excluded remains in
effect and will be restored when the
parent is re-selected.

BSD Support is ready to help with any
questions you may have about this
process.

To discuss the pros and cons of using
outline specs, please contact our spec
writers at smcclendon@bsdsoftlink.com.

Outline Specs
continued from page 7
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